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Legal Information

© Hangzhou Microimage Software Co., Ltd. All rights reserved.

About this Manual
The Manual includes instructions for using and managing the Product. Pictures, charts,
images and all other information hereinafter are for description and explanation only. The
information contained in the Manual is subject to change, without notice, due to firmware
updates or other reasons. Please find the latest version of this Manual at the HIKMICRO
website ( http://www.hikmicrotech.com ).
Please use this Manual with the guidance and assistance of professionals trained in
supporting the Product.

Trademarks

 and other HIKMICRO's trademarks and logos are the properties
of HIKMICRO in various jurisdictions.
Other trademarks and logos mentioned are the properties of their respective owners.

Disclaimer
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THIS MANUAL AND THE
PRODUCT DESCRIBED, WITH ITS HARDWARE, SOFTWARE AND FIRMWARE, ARE
PROVIDED "AS IS" AND "WITH ALL FAULTS AND ERRORS". HIKMICRO MAKES NO
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION,
MERCHANTABILITY, SATISFACTORY QUALITY, OR FITNESS FOR A PARTICULAR PURPOSE.
THE USE OF THE PRODUCT BY YOU IS AT YOUR OWN RISK. IN NO EVENT WILL HIKMICRO
BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL, INCIDENTAL, OR INDIRECT
DAMAGES, INCLUDING, AMONG OTHERS, DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, OR LOSS OF DATA, CORRUPTION OF SYSTEMS, OR LOSS OF
DOCUMENTATION, WHETHER BASED ON BREACH OF CONTRACT, TORT (INCLUDING
NEGLIGENCE), PRODUCT LIABILITY, OR OTHERWISE, IN CONNECTION WITH THE USE OF
THE PRODUCT, EVEN IF HIKMICRO HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES OR LOSS.
YOU ACKNOWLEDGE THAT THE NATURE OF THE INTERNET PROVIDES FOR INHERENT
SECURITY RISKS, AND HIKMICRO SHALL NOT TAKE ANY RESPONSIBILITIES FOR
ABNORMAL OPERATION, PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM
CYBER-ATTACK, HACKER ATTACK, VIRUS INFECTION, OR OTHER INTERNET SECURITY
RISKS; HOWEVER, HIKMICRO WILL PROVIDE TIMELY TECHNICAL SUPPORT IF REQUIRED.
YOU AGREE TO USE THIS PRODUCT IN COMPLIANCE WITH ALL APPLICABLE LAWS, AND
YOU ARE SOLELY RESPONSIBLE FOR ENSURING THAT YOUR USE CONFORMS TO THE
APPLICABLE LAW. ESPECIALLY, YOU ARE RESPONSIBLE, FOR USING THIS PRODUCT IN A
MANNER THAT DOES NOT INFRINGE ON THE RIGHTS OF THIRD PARTIES, INCLUDING
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WITHOUT LIMITATION, RIGHTS OF PUBLICITY, INTELLECTUAL PROPERTY RIGHTS, OR
DATA PROTECTION AND OTHER PRIVACY RIGHTS. YOU SHALL NOT USE THIS PRODUCT
FOR ANY PROHIBITED END-USES, INCLUDING THE DEVELOPMENT OR PRODUCTION OF
WEAPONS OF MASS DESTRUCTION, THE DEVELOPMENT OR PRODUCTION OF CHEMICAL
OR BIOLOGICAL WEAPONS, ANY ACTIVITIES IN THE CONTEXT RELATED TO ANY
NUCLEAR EXPLOSIVE OR UNSAFE NUCLEAR FUEL-CYCLE, OR IN SUPPORT OF HUMAN
RIGHTS ABUSES.
PLEASE FOLLOW ALL THE PROHIBITIONS AND EXCEPTIONAL CAVEATS OF ALL
APPLICABLE LAWS AND REGULATIONS, IN PARTICULAR, THE LOCAL FIREARMS AND/OR
HUNTING LAWS AND REGULATIONS. PLEASE ALWAYS CHECK NATIONAL PROVISIONS
AND REGULATIONS BEFORE PURCHASE OR USE OF THIS PRODUCT. PLEASE NOTE THAT
YOU MAY HAVE TO APPLY FOR PERMITS, CERTIFICATES, AND/OR LICENSES BEFORE ANY
PURCHASING, SELLING, MARKETING AND/OR USING OF THE PRODUCT. HIKMICRO
SHALL NOT BE LIABLE FOR ANY SUCH ILLEGAL OR IMPROPER PURCHASING, SELLING,
MARKETING, AND END USES AND ANY SPECIAL, CONSEQUENTIAL,INCIDENTAL, OR
INDIRECT DAMAGES ARISING THEREOF.
IN THE EVENT OF ANY CONFLICTS BETWEEN THIS MANUAL AND THE APPLICABLE LAW,
THE LATTER PREVAILS.
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Symbol Conventions

The symbols that may be found in this document are defined as follows.

Symbol Description

Danger
Indicates a hazardous situation which, if not avoided, will or
could result in death or serious injury.

Caution
Indicates a potentially hazardous situation which, if not avoided,
could result in equipment damage, data loss, performance
degradation, or unexpected results.

Note Provides additional information to emphasize or supplement
important points of the main text.
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Chapter 1 Introduction

The client is designed to configure and manage devices in a unified and intuitive manner. It
provides multiple functionalities, including device management, live view, video recording,
real-time temperature information display, history temperature search, device remote
configuration, etc.
This user manual describes the functions, configurations and operation steps of the client.
To ensure the properness of usage and stability of the client, refer to the contents below
and read the manual carefully before installation and operations.
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Chapter 2 Running Environment

The followings are the recommended running environments for installing the client.
● Microsoft Windows 7 / Windows 8 / Windows 10 / Windows 11 (64-bit operating

system)
● CPU: i5 or above
● RAM: 8G or above
● Graphics Card: Discrete GPU recommended

Note
Previewing multiple videos and high frame rate demands require higher computer
specifications.
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Chapter 3 Service Management

The Service is mainly applicable for data storage, data management, and data calculation.
With continuous running and processing, it can manage the data, such as event records. It
also provides management for user permissions, devices, logs, etc.
● You can view the module running status, and click Edit Port to edit its ports. You need to

restart the Service to take effect.
● Check Auto-Launch to enable launching the Service automatically after the PC started

up.

Note
● When exiting the client, you can choose to exit the Service at the same time.
● The Service should run on the same computer with the client.
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Chapter 4 Device Management

The client supports thermographic automation cameras. After adding devices, you can
perform live view, configure temperature measurements, view real-time temperatures,
search history temperatures, etc.

4.1 Activate Devices
For the inactive devices, you are required to create a password to activate them before
they can be added to the software and work properly.

Before You Start
Make sure the device to be activated is connected to the network and on the same subnet
with the PC where the client runs.

Steps

Note
This function should be supported by the device.

1. On the Maintenance and Management panel on the right side of the client, Click Device
Management > Device .

2. Click Online Device to show the online device list at the bottom of the page.
3. Select one or more inactive devices and click Activate.

Note
If multiple devices are selected, only one dialog window will pop up. Usually, the names
and passwords of the selected devices are the same.

4. Create a password and confirm the password.

Caution
The password strength of the device can be automatically checked. We highly
recommend you change the password of your own choosing (using a minimum of 8
characters, including at least three kinds of following categories: upper case letters,
lower case letters, numbers, and special characters) in order to increase the security of
your product. And we recommend you change your password regularly, especially in the
high security system, changing the password monthly or weekly can better protect your
product.
Proper configuration of all passwords and other security settings is the responsibility of
the service provider and/or end-user.

5. Click OK to activate the device.
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6. Optional: In the Operation column, click  to edit the network information (including
device name, IP address, port number, etc.) for the online device.

4.2 Add Device
The client provides various device adding modes including IP/domain and IP segment. It
also supports adding detected online devices.

4.2.1 Add Single or Multiple Online Devices

The client can detect online devices which are in the same network as the PC running the
client. You can select a detected online device displayed in the online device list and add it
to the client. For detected online devices sharing the same user name and password, you
can add them to the client in a batch.

Before You Start
● The device(s) to be added are on the same network as the PC running the client.
● The device(s) to be added have been activated.

Steps
1. In the Maintenance and Management area, click Device Management > Device .
2. Click Online Device to show the online device list at the bottom of the page.
3. In the Online Device area, check one or more online device(s), and click Add to open the

device adding window.
4. Enter the required information.

Name
Create a descriptive name for the device. For example, you can use a nickname that
can show the location or feature of the device.

IP Address
Enter the device's IP address. The IP address of the device is obtained automatically
in this adding mode.

Port
The port number of the device is obtained automatically in this adding mode and
editing is supported.

User Name
Enter the user name of the device(s). By default, the user name is admin.

Password
Enter the device password.
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Caution
The password strength of the device can be automatically checked. We highly
recommend you change the password of your own choosing (using a minimum of 8
characters, including at least three kinds of following categories: upper case letters,
lower case letters, numbers, and special characters) in order to increase the security
of your product. And we recommend you change your password regularly, especially
in the high security system, changing the password monthly or weekly can better
protect your product.
Proper configuration of all passwords and other security settings is the responsibility
of the service provider and/or end-user.

Import to Group
Check Import to Group to create a group by the device name, and import all the
channels of the device to the group.

5. Finish adding the device.
- Click Add to add the device and back to the device list page.
- Click Add and New to save the settings and continue to add other devices.

4.2.2 Add Device by IP Address or Domain Name

If you know the IP address or domain name of the device to add, you can add devices to
the client by specifying the IP address (or domain name), user name, password, etc.

Steps
1. In the Maintenance and Management area, click Device Management > Device .
2. Click Add.
3. Select IP/Domain as the adding mode.
4. Enter the required information.

Name
Create a descriptive name for the device. For example, you can use a nickname that
can show the location or feature of the device.

IP Address
Enter the device's IP address. The IP address of the device is obtained automatically
in this adding mode.

Port
Enter the device port No. The default value is 8000.

User Name
Enter the user name of the device(s). By default, the user name is admin.

Password
Enter the device password.
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Caution
The password strength of the device can be automatically checked. We highly
recommend you change the password of your own choosing (using a minimum of 8
characters, including at least three kinds of following categories: upper case letters,
lower case letters, numbers, and special characters) in order to increase the security
of your product. And we recommend you change your password regularly, especially
in the high security system, changing the password monthly or weekly can better
protect your product.
Proper configuration of all passwords and other security settings is the responsibility
of the service provider and/or end-user.

Import to Group
Check Import to Group to create a group by the device name, and import all the
channels of the device to the group.

5. Finish adding the device.
- Click Add to add the device and back to the device list page.
- Click Add and New to save the settings and continue to add other devices.

4.2.3 Add Devices by IP Segment

If the devices share the same port No., user name and password, and their IP addresses
ranges in the same IP segment, you can add them to the client by specifying information
like start IP address and the end IP address, port No., user name, and password of devices.

Steps
1. In the Maintenance and Management area, click Device Management > Device .
2. Click Add.
3. Select IP Segment as the adding mode.
4. Enter the required information.

Start IP
Enter a start IP address.

End IP
Enter an end IP address in the same network segment with the start IP.

Port
Enter the device port No. The default value is 8000.

User Name
Enter the user name of the device(s). By default, the user name is admin.

Password
Enter the device password.
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Caution
The password strength of the device can be automatically checked. We highly
recommend you change the password of your own choosing (using a minimum of 8
characters, including at least three kinds of following categories: upper case letters,
lower case letters, numbers, and special characters) in order to increase the security
of your product. And we recommend you change your password regularly, especially
in the high security system, changing the password monthly or weekly can better
protect your product.
Proper configuration of all passwords and other security settings is the responsibility
of the service provider and/or end-user.

5. Optional: Check Import to Group to create a group by the device name, and import all the
channels of the device to the group.

6. Finish adding the device.
- Click Add to add the device and back to the device list page.
- Click Add and New to save the settings and continue to add other devices.

4.3 Manage Added Devices
After adding devices to device list, you can manage the added devices including editing
device parameters, remote configuration, viewing device status, etc.

Table 4-1 Manage Added Devices

Edit Device Click  to edit device information including device name, address,
user name, password, etc.

Delete Device Check one or more devices, and click Delete to delete the selected
devices.

Remote
Configuration

On the device list page, click  in the Operation column to
perform remote configuration for a device. For details, refer to the
user manual of device.

Refresh Device
Information

Click  to refresh and get the latest device information.

4.4 Group Management
The client provides groups to manage the added resources in different groups. You can
group resources into different groups according to the resources' locations.

Example
For example, on the 1st floor, there are 64 cameras mounted. You can organize these
resources into one group (named 1st Floor) for convenient management. You can perform
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operations like live view and do other operations of the devices after managing the
resources by groups.

4.4.1 Group Resources

The client provides two methods of adding a group: customizing a group or creating a
group by device name. After customizing a group, you need to import resources into this
group manually. After creating a group by the device name, the resources of the device will
be imported into the group automatically. You can choose one method to group your
resources according to actual needs.

Steps
1. In the Maintenance and Management area, click Device Management > Group .
2. Add a group.
- Customize a Group: Click Add Group and create a name for the new group.
- Create a Group by Device Name: Click Create Group by Device Name and select an

added device to create a new group by the name of the selected device. After creating
a group by the device name, the resources (such as encoding channels, alarm inputs,
alarm outputs, and access points) of the device will be automatically imported to the
group.

Note
Up to 256 groups can be added.

3. After adding a group, you need to import resources into the group.

Note
For one resource, it can be added to different groups.

1)Select the type of resources to be imported, and click Import.
2)Select the resources to be imported, and click Import to import all the selected

resources into this group.
4. Optional: After adding a group, perform the following operations.

Expand or Fold
Resource List

● Click  /  to expand or fold the resource list in the group.
● Right-click a group name and select Expand All/Collapse All to

delete the group.

Search
Resource

Enter the keyword and click  to search target resources.

Remove
Resource from
Group

Select the resource(s) of a group and click Delete to delete the
selected resource(s).
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Delete Group ● Select a group and click Delete Group to delete the group.
● Hover the cursor over a group and click  to delete the group.
● Right-click a group name and select Delete to delete the group.

Rename Group ● Hover the cursor over a group and click  to rename the group.
● Right-click a group name and select Rename to rename the

group.

4.4.2 Edit Resource Parameters

You can edit parameters of a resource in a group.

Before You Start
Make sure the resources have been imported to the group.

Steps
1. In the Maintenance and Management area, click Device Management > Group .
2. Select a group in the group list and click Encoding Channel.

The resources imported to the group will be displayed.
3. In the Operation column, click  .
4. Edit the camera information, including the camera name, the stream type, etc.

Stream Type
If Auto-Change Stream Type is selected, camera will select a stream type according
to its display window size. When the window division number is smaller than 9, the
stream type will be main stream, otherwise sub stream.

Rotation Type
Select the rotate type for the live view or playback of the camera as desired.

Protocol Type
Select the transmission protocol for the camera. You should start live view again to
take effect.

Streaming Protocol
Select the protocol as RTSP or private for getting stream when live view. You should
start live view again to take effect.

5. Click OK.
6. Optional: Click Copy to… to copy the configured parameters to other cameras.
7. Optional: Perform the following operations.

Remote
Configuration

In the Operation column, click  to perform remote configuration
for a device. For details, refer to the user manual of device.

Update Resource
Name

You can update the resource names in a channel.
Select the resource(s) and click Update Camera Name to update
the selected camera names.
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Note
This function should be supported by the device.
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Chapter 5 Live View

You can view the live video of the added network cameras on the Main View page. And
some basic operations are supported, including picture capturing, manual recording,
window division, PTZ control, real-time temperature measurement.

5.1 Live View Toolbar
The live-view toolbar can help you operate and manage the live-view window more
conveniently. For example, you can capture picture, record the audio, adjust the volume,
and split the window by the one-click of the tools on the toolbar.

Table 5-1 Descriptions of Toolbar

Icon Function Name Function Description and Operation

Stop Live View Stop all the live view cameras.

 / Mute/Cancel
Mute

Click  to pop up the volume bar, and click  to
cancel the mute and you can adjust the volume.
Click  to pop up the volume bar, and click  again
to set the live-view cameras as mute.

Window Division Select the different window division mode for live
view. Click  to select one window division mode
(e.g. 9 window division).
You can also click Add to customize a window
division mode.

Full Screen Display the live view in full screen. Press Esc key to
exit full screen mode.

Table 5-2 Description of Icons on Live View Window

Icon Function Name Function Description and Operation

Stop Live View Stop the live view of the current window.

Capture Manually capture the pictures for the live view
window.

Capture Raw
Image

Manually capture a radiometric image during live
view.
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Icon Function Name Function Description and Operation

 / Start Recording/
Stop Recording

Click the first time to start recording and click again
to stop recording, and automatically save the
recording files to the path you have set.

Manual
Temperature
Measurement

Click on the live view image to show the temperature
of the selected point. The temperature of the clicked
points is displayed on the image, and the display
duration is dependent on the device's configuration.

PTZ Control Start PTZ mode for speed dome. Click and drag in
the view to perform the PTZ control. For details, refer
to PTZ Control .

Two-Way Audio Start the two-way audio with the device in live view.

Digital Zoom Enable the digital zoom function. Scroll the wheel to
enlarge the live view image.

Stream Select a stream type as needed.

Note
You can also right-click the live video image to enable the functions corresponding to the
icons on the live view window.

5.2 Customize Window Division
The client provides multiple kinds of predefined window divisions. You can also customize
window divisions as desired.

Steps
1. On the Home page, click Main View.
2. At the bottom of the page, click  .
3. Click Add.
4. Create a name for the custom division.
5. Enter the window numbers in both horizontal and vertical dimensions.
6. Optional: Drag your mouse to select the adjacent windows, and click Joint to joint them

as a whole window.
7. Optional: Select the joint window and click Restore to cancel the joint.
8. Click Save.

Note
Up to 5 window divisions can be customized.

9. Optional: After customizing the window division, perform the following operation.
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Edit Custom Division Click  > Edit to edit the division.

Delete Custom Division Click  > Edit > Delete to delete the division.

5.3 Start Live View
You can start live view after adding the device(s) to the client so that you can get to know
the monitored area well. You can start the live view of one camera or all cameras in a
group.

Click Main View > Device . On the left resource list, select the resource(s) and start live
view by the following methods.

Method Description Operation

Start Live
View for One
Camera

Start the live view of only
one camera in a group.

● Select a camera and drag it to the
window.

● Double-click the camera in a group.
● Move your cursor over the camera name,

and click  .

Start Live
View for
Camera
Group

Start the live view of all
cameras in one group
synchronously.

● Select a group and drag it to the window.
● Double-click the group.
● Move your cursor over the group name,

and click  。

Note
● The client automatically saves the current preview state when exiting and allows you to

restore it after restarting.
● If the device supports stream encryption, and the stream of its live view is encrypted, you

are required to enter a stream key for double verification.

5.4 Measure Real-Time Temperature
During the live view, you can monitor real-time temperatures. By configuring
measurements and measurement parameters, you can also monitor temperatures of
specific areas and spot.

5.4.1 Configure Measurements

The measurements include point measurement, line measurement, and area measurement
to meet the requirements of different temperature measurement scenes.
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1. Start the live view.
2. Right-click a live view window and select Edit Measurement to open the configuration

window.
3. Switch on Enable ROI Thermometry or select the detection mode as Expert Mode to

measure temperature of interested areas or spots.

Note
- The parameters displayed may vary with different devices.
- This function is not supported by handheld devices.
- When the mode is Normal Mode, configuring measurements is not supported.

4. Create a name for the measurement.
5. Perform one of the following operations to draw measurements.

Note
The maximum number of measurements is determined by the device capability.

Figure 5-1 Measurements

Point Measurement
You can customize a measurement point to view the temperature of this point.
Click  , and click on the live view image to select a point to be monitored. The
customized point will be added.

Line Measurement
Click  , and then draw a line on the live view image.

Area Measurement
Supports drawing areas (including rectangle, circle, ellipse, and polygon) for measurement.
You can draw different area shapes as needed. For example, for an irregular area, you can
choose to draw a polygon for measurement.
● Click  and left-click the mouse to draw the area, which will be displayed as a rectangle,

circle, or ellipse automatically. Right-click the mouse to finish drawing the area.
● Click  left-click the mouse to draw the first line of the polygon, left-click the mouse

again to draw the next line. Right-click the mouse to finish drawing the polygon.

Delete Measurement
Click  to delete the selected measurement.
Click  to delete all measurements.
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Edit Measurement
Click  , and then select a measurement to adjust. For example, you can drag the end of
the measurement line to stretch or shorten it. For the rectangle measurement, you can
click the angle of the rectangle to enlarge or narrow it.

5.4.2 Set Measurement Parameters

You can set different measurement parameters for better temperature monitoring.

Open the measurement configuration window.
Set parameters as needed and click OK.
Alarm Type

When the max. temperature / avg. temperature / min. temperature is above or below the
alarm temperature or pre-alarm temperature, the alarm will be triggered.

Pre-Alarm Temperature
When the max. temperature / avg. temperature / min. temperature is above or below the
pre-alarm temperature, the alarm will be triggered.

Alarm Temperature
When the max. temperature / avg. temperature / min. temperature is above or below the
alarm temperature, the alarm will be triggered.

Distance
The distance between the object and the thermal device.

Emissivity
Every object has emissivity, which can be affected by surface temperature, surface
roughness, degree of oxidation, coating, etc. Emissivity = Measured Value / Standard
Value. The measured value refers to the temperature measured by infrared
measurement devices, and the standard value is measured by contact measurement
devices. Since any object is impossible to have no reflection at all, this value is generally
less than 1.

Reflected Temperature
When objects with low emissivity are monitored, the reflected temperature can be
significantly affected. The way of measuring reflected temperature: first select the
location of the measurement target, and then find the reflecting surface according to
your position and the measurement target (referring to the optical light path diagram),
and measure its temperature by setting the emissivity as 1. The average temperature of
the reflecting surface is the reflected temperature.
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Note
Click Remote Configuration to perform remote configuration for a device. For details, refer
to the user manual of device.

5.4.3 View Real-Time Temperature

During the live view, you can view global temperature information. If you have configured
measurements, you can also view temperature information of specific areas or spots.

Enter the Main View module and start the live view of the device(s). The real-time
temperature line chart will be displayed.

Note
● If no measurement is configured, the temperature information is global. Under the live

view windows, click  to view the global temperature line chart.
● If measurements have been configured, under the live view windows, click  to view the

temperature line chart of the measurement(s).
● Move the cursor over the chart to view temperature details.

Figure 5-2 Real-Time Temperature Line Chart
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You can perform the following operations as needed.
● Right-click a live view window, and select Hide Measurement to hide measurements on

the live view image.
● Right-click a live view window, select Display Temperature Info., and select Max. Temp.,

Min. Temp. or Avg. Temp. to display the selected temperature type on the live view
image.

● Right-click a live view window and select the Display Mode.
Live View Mode

The window only display the live view.
Temperature Mode

The widow display only display real-time temperature information.

Note
For the same resource, you can display the content under the two modes in two
windows respectively at the same time.

● In the lower right corner of the client, click  to hide or display the temperature line
chart.

● Click  to enter Search History Temperature module and search history temperature
information. For details, refer to Search History Temperature .

5.5 PTZ Control
The software provides PTZ control for cameras with pan/tilt/zoom functionality. During
the PTZ control, you can set preset, patrol, and pattern, and you can also open a new
window for controlling the PTZ.

Note
Some functions should be supported by the device.

5.5.1 PTZ Control Panel

The software provides PTZ control operations via control panel, such as detection, speed,
zoom in, zoom out, etc.

Enter the Main View module, and select PTZ Control to open the PTZ control panel.
The following icons are available on the PTZ control panel.
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Table 5-3 Icons on PTZ Control Panel

Icon Name Description

PTZ Click or hold the left mouse button to turn the
PTZ around.
Click  to turn around the PTZ horizontally and
continuously; click again to stop turning.

Speed Control Drag the slider to adjust the PTZ moving speed.

Zoom In/Out Zoom in to view close image for details; zoom
out to view a panoramic image.

Focus +/- Click Focus + move the focal point forward, and
click Focus - to move the focal point backward.

Iris +/- Used for adjusting the luminance of the image.
The larger the iris is, the more the light enters,
and the brighter the image will be.

3D Positioning Use the left key of mouse to click on the desired
position in the video image and drag a rectangle
area in the lower right direction, then the dome
system will move the position to the center and
allow the rectangle area to zoom in. Use the left
key of mouse to drag a rectangle area in the
upper left direction to move the position to the
center and allow the rectangle area to zoom out.

Auxiliary Focus Click to focus automatically.

Lens Initialization Initialize the lens and focus again for a clear
image.

Light Click to fill light.

Wiper Use the wiper to clear the dust on the camera
lens.

Manual Tracking For speed dome with auto-tracking function,
enable the auto-tracking (via right-click menu)
for it and click the icon to manually track the
target by clicking on the video.

Menu For analog speed dome, click the icon to display
its local menu. For detailed operation of the
menu, refer to user manual of the speed dome.
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Icon Name Description

One-Touch Patrol For speed dome with one-touch patrol function,
click the icon and the speed dome starts patrol
from the predefined preset No.1 to preset No.32
in order after a period of inactivity (park time).
For setting the park time, refer to user manual of
the speed dome.

One-Touch Park For the speed dome with one-touch park
function, click the icon and the speed dome
saves the current view to the preset No.32. The
device starts to park at preset No. 32
automatically after a period of inactivity (park
time). For setting the park time, refer to user
manual of the speed dome.

Enable Manual
Lens De-Icing
Heater

Enable this function to ensure the camera
performance by heating.

Note
We suggest you enable this function when the
environment temperature is under 0 °C,
otherwise the high temperature may affect the
camera work.

Manual Face
Capture

Click this button, and hold the left mouse button
to select a face in the image to capture it. The
picture will be uploaded to the server for viewing.

Synchronize FOV For thermal cameras, click the icon to
synchronize the optical channel's field of view
with that of the thermal channel.

Regional Focus For speed domes, click the icon and draw a
rectangle on the image to optimize the focus
effect in this region.

Regional Exposure For speed domes, click the icon and draw a
rectangle on the image to optimize the exposure
effect in this region.
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5.5.2 PTZ Control in Window

With the PTZ control direction icons in the live view window, you can make the PTZ scan
automatically and move to the direction of the icon.

Right-click a live view window, and select Open PTZ Control. The live view window will be
divided into 3×3 virtual areas which will not be displayed on the interface. Move the cursor
over different areas, the PTZ control icons will be displayed.
Click the central area, the PTZ will scan automatically; click the other areas, the PTZ will
move to the direction of the icon, and will move quickly via long pressing the mouse.

Figure 5-3 PTZ Control in Window

5.5.3 Set Preset, Patrol, and Pattern

PTZ control supports setting and calling a preset, patrol, and pattern.

On the Home Page, click Main View > PTZ Control to show the PTZ Control panel.

Task Definition Operation

Preset A preset links the key
regions to mobile PTZ
position and status.
Monitoring people uses it to
positioning to key regions
rapidly. By sending setting
preset command, mobile
PTZ records the position and
status of zoom, focus, and
iris. When executing calling
preset command, mobile
PTZ rapidly rolls to the set

Click  .
How to Set: select a preset from the
preset list→turn the camera to a
desired position→click  。
Move the cursor over a preset and
click  to delete it.

How to Call: click  。
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Task Definition Operation

position and resume to set
status.

Pattern By recording pattern, the
movement path and the
dwell time in a certain
position can be recorded
precisely. By calling pattern,
mobile PTZ starts move
totally according to the
recorded path.

Click  .
How to Set: click  to start recording a
pattern→click the direction buttons to
shape the pattern→click  .
Move the cursor over a pattern and
click  to delete it.

How to Call: click  .

Patrol Patrol is the function that
users specify a scan track
with a group of defined
presets. The patrol between
two presets is performed
with the set speed and time.

Note
Make sure at least two presets have
been set.

Click  .
How to Set: click  →select presets,
and set speed and time→click OK.
Move the cursor over a patrol and click

 to delete it.

How to Call: click  .

5.6 Manually Record and Capture
During live view, you can manually record videos, and capture normal/raw images, and
then view the recorded videos and captured images on the local PC.

5.6.1 Manually Record Video

You can record the live video on the Main View page manually, and store the video files in
the local PC.

Steps
1. Open the Main View page.
2. Start the live view.

Note
See Start Live View for details.

3. Perform one of the following operations to start manual recording.
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- Move the cursor to the live view window to show the toolbar and click  on the
toolbar.

- Right-click on the live video and click Start Recording on the right-click menu.
4. Click  to stop the manual recording.

Note
● During the manual recording, the icon of the camera turns to  .
● The saving path of the recorded video files can be set on the System Configuration >

File page.

The recorded video file is automatically saved to the local PC, and a small window with
the saving path information pops up in the lower-right corner of desktop. Click Open
Folder to open the folder of the recorded file on the local PC.

5.6.2 View Local Videos

You can view the recorded videos stored on your local PC.

Steps
1. Click  > File > Open Video File in the upper-right corner.
2. Select the camera to search the recorded video files.
3. Specify the start time and end time in the lower-left corner for the searching.
4. Click Search.

The video files recorded between the start time and end time displays in the thumbnail
format on the page.

5. Optional: Perform the following operations after the search.

Playback Double-click a normal video file to start local playback.
During the playback, operations including pause, stop, speed,
single frame, digital zoom, volume control, capture, and opening
file are supported.

Delete Video
File(s)

Select one or multiple video files, and click Delete.

Save Video
File(s)

Select one or multiple video files, and click Save as.

5.6.3 Capture Pictures

You can capture pictures during the live view.

Steps
1. Open the Main View page.
2. Start the live view.
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Note
See Start Live View for details.

3. Perform one of the following operations to capture pictures.
- Move the cursor to the live view window to show the toolbar and click  on the

toolbar.
- Right-click the live video and click Capture on the right-click menu.
The captured picture is automatically saved to the local PC, and a small window with the
picture thumbnail and saving path information pops up in the lower-right corner of the
desktop. Click Open Folder to open the folder of the captured image on the local PC.

Note
The saving path of the captured pictures can be set on the System Configuration > File
page.

5.6.4 Capture Raw Images

You can capture raw images during the live view.

Steps
1. Open the Main View page.
2. Start the live view.

Note
See Start Live View for details.

3. Perform one of the following operations to capture raw images.
- Move the cursor to the live view window to show the toolbar and click  on the

toolbar.
- Right-click the live video and select Capture Raw Image.
The captured picture is automatically saved to the local PC, and a small window with the
picture thumbnail and saving path information pops up in the lower-right corner of the
desktop. Click Open Folder to open the folder of the captured image on the local PC.

Note
The saving path of the captured pictures can be set on the System Configuration > File
page.

5.6.5 View Captured Images

The normal/raw images captured during the live view are stored on the PC running the
software. You can view the captured images if needed.

HIKMICRO Studio

24



Steps
1. Click  > File > Open Captured Image in the upper-right corner.
2. Select the camera to search the captured images.
3. Specify the start time and end time in the lower-left corner for the searching.
4. Click Search.

The images captured between the start time and end time display in thumbnail format
on the page.

5. Perform the following operations after the search.

Only Display
Normal/Raw Images

Select Image/Raw Image.

Preview Image Double-click a normal image thumbnail to enlarge it for a
better view.

Delete Image(s) Select one or multiple captured image(s), and click Delete.

Save Image(s) Select one or multiple captured images, and click Save as to
save a new copy of the selected image(s).

5.7 More Functions
There are some more functions supported in the live view, including two-way audio, setting
stream type, and locking the client.

Two-Way Audio
Two-way audio function enables the voice talk of the camera. You can get not only the live
video but also the real-time audio from the camera. If the device has multiple two-way
audio channels, you can select a channel to start two-way audio.

Note
● The two-way audio can be used for only one camera at one time.
● When a device (channel) has started two-way audio with a client, the new request for

two-way audio will be failed.

Adjust Volume
Right-click a live view window and select Audio On to adjust the volume. Right-click again
and select Mute to disable the audio of the live view.

Full Screen
Right-click a live view window and select Full Screen to enter the full-screen mode. Right-
click again and select Quit Full Screen or press Esc to exit.
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Lock/Unlock Client
At the top of the client, click  to lock the client.
Click Unlock to enter the login password and click Unlock to unlock the client.

Edit Resource Name
In the resource list, move the cursor over a camera name, and click  > Modify Camera
Name to edit the name.

Remote Configuration
In the resource list, move the cursor over a camera name, and click  > Remote
Configuration to perform remote configuration for a device. For details, refer to the user
manual of device.

Set Stream Type
Auto-Change Stream Type

Camera selects stream type according to its display window size. When the window
division number is smaller than 9, the stream type will be main stream, otherwise sub
stream.

Three ways are provided for setting stream type:
● In the resource list, hover the cursor on a camera's name and click  > Stream to

select a stream type, or click Auto-Change Stream Type.
● Click  in the live view tool bar and select a stream type.
● Right-click a live view window and click Stream to select a stream type for the camera.

Note
This function needs to be supported by device.

Lock Client in Full Screen Mode
Press Ctrl and L on your keyboard to lock the client after entering the full screen mode.
After locking the client, you will be unable to operate the client including the other windows
in the current window division mode. Click Unlock on the top and enter the login password
for the client and click Unlock to unlock the client.
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Chapter 6 Event Center

The event information received by the client displays in Event Center. In the Event Center,
you can check the detailed information of the real-time and historical events, view the
event related video, and so on.

Note
The client will receive alarms (temperature measurement alarm, temperature sudden
change alarm, temperature difference alarm, and device offline alarm) uploaded by the
device. For details about alarm configuration, refer to the user manual of the device.

6.1 Enable Receiving Event from Devices
Before the client can receive event notifications from the device, you need to arm the
device first.

Steps
1. Click  > Tool > Device Arming Control .

Figure 6-1 Device Arming Control
2. Perform the following operations as needed.
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Arm All / Disarm
All

Click Arm All to arm all the added devices; click Disarm All to
disarm all the added devices.

Arm/Disarm One
Device

Turn on the switch in the Operation column to arm the device;
turn off the switch to disarm the device.

Note
The device will be automatically disarmed once it is deleted or disconnected.

6.2 View Real-Time Events
You can view the real-time event information (including event source, event type, event
time, event details, etc.) received by the client.

Before You Start
Enable receiving events from devices so that the client can receive events from the device,
see Enable Receiving Event from Devices for details.

Steps
1. Click Event Center > Real-Time Event .

The real-time event information (including event source, event type, event time, event
details, etc.) will be displayed on the table.

Note
● Right-click the table header of the event list to customize the event related items to be

displayed on the event list.
● Up to 1,000 events can be displayed on the event list.

Event Source
The resource that triggers the event, such as the device and channel.

Event Time
The time when the platform receives the event.

2. Optional: Enter keywords in the search box on the upper right to filter the events.
3. Select an event in the event list to view the event details.

Note
● The event details include the captured picture, live video, and other event information.
● To view the captured pictures, you need to configure picture storage in the system

configuration. See Set Alarm Picture Storage for details.
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Figure 6-2 View Real-Time Events
4. Optional: Perform the following operations if necessary.

Auto-Play Video Check Auto-Play Video to automatically play video when
displaying event details.

Select the Latest Event
Automatically

Check Auto-Select Latest Event to select the latest event
automatically and the event details will be displayed.

Clear Events Click Clear to clear the all the events in the event list.

Enable/Disable Alarm
Audio

Click Audio On/Mute to enable/disable the audio of the
event.

6.3 Search Historical Events
You can search and view historical events by setting search conditions including time,
resource, etc. and export the searched events.

Steps
1. Click Event Center > Search Alarm Event or Event Center > Search Event Diagnosis to

enter the event search page.
2. Set the filter conditions.

Time
The time when the client receives the event.

Resource
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The root nodes are the group names, and the child nodes are the channels.
Type

The type refers to the cause of the diagnosis event.
3. Click Search to search the events according the set conditions.

Figure 6-3 Search Historical Alarm Events

Note
Right-click the table header of the event list to customize the event related items to be
displayed in the event list.

4. Optional: Select an event in alarm event list to view the captured picture(s).

Note
To view the captured picture(s), you need to configure picture storage in the System
Configuration.

5. Optional: Click Export or Export All to export selected or all events to the local PC.

Note
You can choose to export all, only logs, or only pictures of the searched alarm events.

6.4 View Pop-up Event Information
If you have enabled event notification and set Alarm Triggered Pop-up Image as its linkage
action, a window will pop up when the event happens, showing the event information,
related pictures, and related videos.
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Go to Event Center > Real-Time Event , and then click Enable Alarm Triggered Pop-up
Image to enable the function.

Figure 6-4 The Pop-up Event Information

You can view the event related video footage (from 30 s before the event to the end of the
event), the picture captured when the event happens, as well as the event details such as
event source, event type, event time, etc.

Note
● When the window is not closed, you should click Next to view the new event information

if a new event is triggered.
● If you have exited the window, when a new event is triggered, the new event information

will pop up; if you haven't clear the event information, you can click Previous to view the
previous event information.

You can check Auto-Update Event to enable the window to automatically switch to the
latest event information when a new event is triggered.
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6.5 Other Functions
You can enable the alarm output function for specific resource.

After the alarm output is enabled, when an alarm or pre-alarm is triggered, the client will
caution the user.
Operation: click  > Tool > Alarm Output Control . Select a resource and switch on  in
the Operation column.

Figure 6-5 Alarm Output
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Chapter 7 Search History Temperature

You can search history temperatures according to the comparing variable, camera,
temperature type, report type, and temperature measuring time.

Before You Start
Make sure that you have enabled the temperature storage in the system configuration. See
Set General Parameters for details.

Steps
1. Open the Search History Temp. page.
2. Set the search conditions.

Comparing Variable
The variable for temperature comparing.
Time

Select a measurement under one camera, and temperature data collected via the
selected measurement during two specified time periods will be displayed and
compared.

Measurement
Select two measurements under one or two cameras, and temperature data
collected via the two measurements during the same time period will be displayed
and compared.

Camera
The root nodes are the group names, and the child nodes are the cameras. Under the
cameras you can select the measurements, and under the measurements you can
select the temperature types to be displayed (max. temperature, min. temperature,
and average temperature).

Report Type
You can select the daily/weekly/monthly/annual report where the temperature data
collected every minute/hour/day/month will be shown.

Measurement Time
The temperature data collected during this period will be displayed and compared.

Note
When the comparing variable is set as Time, two time periods need to be specified.

3. Click Search to display the temperature report on the right.
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Figure 7-1 History Temperature Report

Note
Up to six temperature curves can be shown. The x coordinates represent the time when
the temperature data is collected, and the y coordinates represent the temperatures.
Move the cursor along the temperature curve, the corresponding temperature will be
shown.

4. Optional: Drag the two vertical edges of the white rectangular frame left/right to adjust
the time range of the report.

5. Optional: Click Export to export the report in CSV format, or click Export Original Record
to export the original data in CSV format.
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Chapter 8 Log Search

Two log types are provided: operation log and system log. The operation logs refer to the
normal operations that the user did on the client, such as adding device, resetting
password, etc.; and the system logs record the system information, such as login, logout,
locking and unlocking, etc. You can search the log files by conditions including the time
and user, and view the log details.

Steps
1. Enter the Log Management page.
2. Click  to set the start time and end time.

Note
The time period should not be longer than 1 month.

3. Select a user to search the log files which are generated when this user operate on the
client.

4. Select Operation Log and/or System Log as the log type(s).
5. Click Search.
6. Optional: Click  on each table header and select to filter the logs.
7. Optional: Click Back Up Logs to save the searched logs to the local PC in XML format.
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Chapter 9 User Management

To improve the system security, the administrator should create different accounts for
different users, and assign different permissions to the users. To avoid multiple people
sharing one user account, managing the user accounts periodically is recommended.

9.1 Add User
The super user and administrator can add new users, and assign different permissions for
different users if needed.

Steps
1. Enter the Account Management page.
2. Click Add.
3. Set the account information.

User Type
Administrator

The administrator account has all permissions by default, and can modify the
passwords and permissions of all operators and its own.

Operator
The operator account has no permission by default and you can assign the
permissions manually. An operator can only change the passwords of its own
account and the accounts which are added by it.

User Name
The maximum length is 16 bytes.

Password
Enter the password and confirm.

Caution
The password strength of the device can be automatically checked. We highly
recommend you change the password of your own choosing (8 to 16 characters,
including at least two kinds of following categories: upper case letters, lower case
letters, numbers, and special characters) in order to increase the security of your
product. And we recommend you change your password regularly, especially in the
high security system, changing the password monthly or weekly can better protect
your product.
Proper configuration of all passwords and other security settings is the responsibility
of the installer and/or end-user.

4. Check to set permissions for the account.
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Function Permission
The added user will have permissions to the checked functions.

Resource Permission
Select a function permission, and check the corresponding resources on the right; the
added user will have permissions to the selected function of the checked resources.

5. Optional: Click Default to restore the default permission settings of this user.
6. Click Save.

Note
Up to 50 user accounts can be added for the client software.

9.2 Change User's Password
The administrator can change the operator's password without entering the old password,
while the administrator should enter the old password when changing the password of
itself.

Before You Start
The user has been added.

Steps
1. Enter the Account Management page.
2. Select the user to change the password, and click Change Password.

Note
3. Optional: Enter the old password.
4. Enter the password and confirm the password.

Caution
The password strength of the device can be automatically checked. We highly
recommend you change the password of your own choosing (8 to 16 characters,
including at least two kinds of following categories: upper case letters, lower case
letters, numbers, and special characters) in order to increase the security of your
product. And we recommend you change your password regularly, especially in the high
security system, changing the password monthly or weekly can better protect your
product.
Proper configuration of all passwords and other security settings is the responsibility of
the installer and/or end-user.

5. Click OK.
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Chapter 10 System Configuration

You can configure system settings including the alarm sound, file saving path, etc.

10.1 Set General Parameters
You can configure the frequently used parameters, including the maximum mode, network
performance, etc.

Steps
1. Select System Configuration > General .
2. Set the general parameters.

Save Data for
The time for keeping the data. Once exceeded the time, the data will be deleted.

Save Temperature Data
After it is enabled and the interval is set, the temperature data collected via the
devices will be automatically saved according to the set interval.

Note
Temperature data collected via one device and one measurement every day will
occupy about 0.78 MB of storage space on your disk.

Temperature Unit
Select the temperature unit to be displayed on the Client as needed.

Note
The new setting will take effect for other modules after restarting the client, but it will
take effect immediately in the Event Details column on the Real-Time Event page.

Maximum Mode
Select Maximize or Full Screen as the maximum mode. Maximize mode can
maximize the display and show the task bar. Full Screen mode can display the client
in full-screen mode.

Network Performance
Set the network conditions to Normal, Better or Best.

3. Click Save.
4. Click Default to restore the default settings.
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10.2 Set Image Parameters
The image parameters that can be configured include the picture type, view scale, play
performance, etc.

Steps
1. Click System Configuration > Image .
2. Configure the image parameters.

Parameter Description

Picture Type The format of the captured picture file. It is JPEG by
default.

View Scale The view scale of the video in live view or playback. It can
be set as Full Screen, 4:3, 16:9, or Original Resolution.

Play Performance The play performance of the live video. It can be set as
Shortest Delay, Balanced, or Fluency, and is set as
Balanced by default.

Hardware Decoding Enable or disable the hardware decoding as needed.

Note
When the graphics card memory is insufficient or the
graphics card performance is poor, it is not
recommended to enable the hardware decoding.

3. Click Save.
4. Click Default to restore the default settings.

10.3 Set File Saving Path
The video (manually recorded during live view) and captured normal/raw images are
stored on the local PC. The saving path of these files can be set.

Steps
1. Click System Configuration > File .
2. Click  and select a local saving path for the files.
3. Click Save.

Note
The client must restart for the changes of saving paths to take effect.

4. Click Default to restore the default settings.

HIKMICRO Studio

39



10.4 Set Alarm Picture Storage
The captured pictures triggered by the events on the devices can be saved on the local PC.
You can set the picture storage location here manually.

Steps
1. Enter the System Configuration page.
2. Click Storage.
3. Switch on Alarm Picture Storage.
4. Select a disk to save the pictures.
5. Click Save.

10.5 Set Alarm Sound
When the event is triggered, the client can give an audible warning to notify the security
personnel. You can set the sound of the audible warning in this section.

Steps
1. Click System Configuration > Alarm .
2. Click  and select the audio file from the local PC.
3. Click Save.
4. Optional: Click Default to restore the default settings.
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Chapter 11 Operation and Maintenance

You can perform operations in the menu, such as device arming control and alarm output
control, to ensure a smooth and convenient usage of the client.

In the upper-right corner of the client, click  and select different items on the menu to
perform the following operations.

Open Files
You can open files of captured pictures, videos, and logs saved on the local PC, and search
or filter the files.

Note
The files of captured pictures and videos can be saved as new copies on the local PC for
backup.

Broadcast
Select one or multiple devices to enable the broadcast function of the devices.

Device Arming Control
You can arm and disarm the devices, and view the arming status of devices. See Enable
Receiving Event from Devices for details.

Alarm Output Control
You can enable the alarm output function for devices. After the alarm output is enabled,
when an alarm or pre-alarm is triggered, the client will caution the user. See Other
Functions for details.

Play Videos via Player
You can use the player to play the recorded videos stored on the local PC.
Click  on the lower right of the player, and select the video file stored on the local PC to
play. During the playback, operations including pause, stop, speed, single frame, digital
zoom, volume control, capture, and opening file are supported.

View Help Information
You can view the client user manual, client name, client version, and open source software
licenses.
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